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Introduction to NVivo Pro 
 
This workshop takes you through the basics of NVivo Pro; one of three editions of NVivo for Windows (the other two 
being NVivo Starter and NVivo Plus). NVivo Pro includes functionality that is able to support most qualitative research 
projects, and features that will be covered in this session include importing data from various sources, coding material 
into nodes and running queries.  
 
1  Exploring the Sample Project 
  

This section explores some of the key features of NVivo Pro using the sample project provided with the 
software: Environmental Change Down East. To access this project you simply need to launch the software, 
either by selecting ‘NVivo 11’ from the list of recently opened programs on your Start menu, or by selecting  
‘All Programs’, scrolling down to the QSR folder, opening the NVivo 11 folder and then selecting NVivo 11. 
You may then be prompted to enter your User Profile, which simply involves entering your staff or student ID 
as your ‘Name’ and entering your initials (you can also change the language if you wish), then pressing ‘OK’. To 
open the sample project you then just need to click on the ‘Sample Project’ icon at the top of the screen. 

 
1.1     The NVivo Workspace 
 
 Once the sample project has opened you can explore the NVivo workspace. You might notice that this looks 

similar to Microsoft Outlook, with features as described and shown below: 
• a ribbon displays all the command options at the top of the screen; 
• Navigation View displays folders on the left of the screen;  
• List View displays folder contents in the middle of the screen; 
• Details View displays project items on the right of the screen; and 
• a status bar displays key information about aspects of your project at the bottom of the screen. 
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 Initially displayed in the Details View should be a guide titled New to NVivo? Get Started Here. To view this 
useful resource (which includes links to video tutorials, online help and a get started guide) at a later time go to: 

 
File → Help → Help Resources → Quick Start Steps 

 
 For the time being, though, close the document by clicking on the ‘Close’ icon on the ‘Quick Start Steps’ tab, 

and then double click on the heading ‘Overview of Sample Project’ in the List View, to see details of the sample 
project (note that while you can have multiple windows open in the Details View, to avoid confusion it is 
generally best to keep these to a minimum). 

 
1.2     Sources 
 

Currently displayed in the Navigation View on the left of screen will be the four folders in the ‘Sources’ group, 
where the sources (i.e. research materials) for the sample project are stored. These folders are as follows:  

• Internals, where you can import or create your sources; 
• Externals, where you can summarise sources you cannot import into your project (e.g. books); 
• Memos, where you can import or create observations and insights; and  
• Framework Matrices, where you can summarise your source materials in a grid. 

The sources we will focus on in this session, and the ones you will typically deal the most with, are the internal 
sources. 
 
When importing sources into NVivo Pro you create your own folders and sub-folders according to how you wish 
to organise your data. For the sample project, for example, the folders and sub-folders that have been used to 
store the internal sources are: 

 
 

By exploring these folders you can see the different types of sources that can be imported into NVivo Pro; from 
text documents and PDFs to images, audio files, video files, social media content and survey data.  
 
Note that after completing this workshop you may also like to explore other groups in the Navigation View of 
the sample project (i.e. ‘Nodes’,’ Queries’, etc.) to get an idea of the scope of the software. 

 
2 Creating a New Project 
 

To create a new project in NVivo Pro go to File -> New, then enter a name and description for your project and 
browse to choose a location to save it in (it will save as a .nvp file). For example: 
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2.1      Creating Folders 
 

It is generally easiest to create folders for your internal sources before you import them, as you can then import 
them straight into the appropriate folder. However note that you can create new folders, move sources 
between folders (by simply dragging and dropping them), and delete folders or sources (by right clicking on 
them and selecting ‘Delete’) at any time. 
 
To create a new folder, for example an Interviews folder for your interview sources, do the following: 

1. Click ‘Sources’ in the Navigation View (if the source folders are not already displayed) 
2. Right click on the Internals folder 
3. Select ‘New Folder’ from the top of the list, and the ‘New Folder’ dialog box will appear 
4. Enter a name for your new folder (e.g. Interviews), and a description if required 
5. Click ‘OK’ 

 
 
(Alternatively, you can create a new folder by clicking on the Internals folder, selecting the ‘Create’ tab on the 
ribbon at the top of the screen, and then selecting the ‘Folder’ option in the ‘Collections’ group.) 
 
Repeat this process to create folders titled Literature, Web Content and Pictures, so that your source folders 
are as follows: 

 
 

2.2      Importing Sources Saved on your Computer 
 

You can now import sources directly into the folders you have created. The simplest types of sources to import 
are those that are saved on your computer; e.g. document, PDF, audio, video, picture and/or survey sources.  

For example, to import document sources into the Interviews folder do the following: 
1. Select the Interviews sub-folder, so that the contents of the folder appear in the List View (at the 

moment there are no sources, so there will just be a list of headings) 
2. Right click in the blank area in the List View 
3. Select ‘Import’ 
4. Select ‘Import Documents…’ 
5. Locate the documents you wish to import (e.g. Margaret.docx, Maria and Daniel.docx, Robert.docx, 

Susan.docx), then import them either by: 
o selecting them individually and pressing ‘Open’ (do this for Margaret.docx); or 
o selecting multiple documents and pressing ‘Open’ (do this for the remaining three) 

6. Click ‘OK’. 
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Note that when importing an individual source a ‘Document Properties’ dialog box will appear giving you the 
opportunity to rename the source and to provide a description and colour if desired; you can still do this for 
documents imported as part of a group by simply right clicking on the relevant imported document in the List 
View, then selecting ‘Document Properties…’. 

 
(Alternatively, you can import a source into a folder by clicking on the appropriate folder, selecting the ‘Data’ 
tab on the ribbon at the top of the screen, and then selecting the ‘Documents’ option in the ‘Import’ group.) 
 
Now import the audio (Helen.mp3) and video (Ken.wmv) interviews into the Interviews folder using the method 
described above, this time selecting the ‘Import Audios…’ and ‘Import Videos…’ options respectively. 
Your list of interview sources should now be as follows: 
 

 
 

Note that you can also import PDF, picture and survey sources in the same way.  
 

2.3      Importing Emails 
 

You can import Outlook emails into NVivo quickly and easily, either by simply dragging the email into the 
appropriate source folder in NVivo or by saving it as a .msg file in Outlook and then importing it; either way it 
will be imported as a PDF. For more information on doing this go to: 
 
http://help-nv11.qsrinternational.com/desktop/procedures/Import_emails.htm 
 
Both of the methods described above will also import any associated email attachments, except for Excel files 
(which need to be saved first and then imported) or any unsupported source types. The attachment(s) will be 
saved in a folder called Email Attachments, created as a sub-folder in the source folder where you have saved 
the email, however you can then move it to another folder (and delete any unnecessary folders) if preferred.  
 
Alternatively you can import email attachments without the associated email. To import the Analyzing  
Estuarine Shoreline Change PDF emailed to you into the Literature folder, for example, do the following: 

1. Select the source folder you wish to import the attachment into in NVivo (e.g. Literature) 
2. Open the email with the attachment(s) that you wish to import (e.g. the email with the Analyzing  

Estuarine Shoreline Change PDF attachment) 
3. Drag the attachment(s) into the List View of the appropriate folder 

 
2.4       Importing Web Content 
  

You can import web content (e.g. articles, blog posts or social media content) into your project using a free web 
browser extension called NCapture. NCapture for Internet Explorer should have been included with your NVivo 
download, and hence should already be installed, but to check open Internet Explorer and look for it listed 
towards the bottom of the Tools menu. Alternatively you can look for the icon in the command bar (if the 
command bar is not displayed simply right click on the ribbon at the top of the screen and select ‘Command 
bar’): 
 
 
 
 

NCapture for 
NVivo icon 

http://help-nv11.qsrinternational.com/desktop/procedures/Import_emails.htm
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If NCapture is not installed for Internet Explorer, if you want to install it for Google Chrome, or if you would like 
more information about it, go to: 

 
http://help-ncapture.qsrinternational.com/desktop/welcome/welcome.htm 
 
Once you have NCapture installed for your chosen web browser, open the browser and go to: 
 
http://www.ncfieldfamily.org/farm/north-carolina-fishing-industry-changes/ 
 
You can import this web article about North Carolina’s fishing industry, for example, into NVivo using NCapture 
by going to: 
 
Tools -> NCapture for NVivo 
 
(Alternatively, click on the NCapture for NVivo icon in the command bar.) 

 
The NCapture dialog box will open as follows: 
 

 
 

Note that you can choose to save an article either as a PDF of the web page, or as a PDF just of the article- 
which should remove additional, unnecessary content (other types of web content will have different source 
type options). Once you have made your selection, check that you are happy with the source name (amend if 
not), add a description if desired, keep the save location as is and click ‘Capture’. 
 
Once you have captured the web content in this way, you can import it into the Web Content folder as follows: 

1. Select the source folder you wish to import the web content into (e.g. Web Content) 
2. Right click in the blank area in the List View 
3. Select ‘Import’ 
4. Select ‘Import from NCapture…’ 
5. Click ‘Browse’ to locate the web content you just captured (e.g. in your Desktop folder) 
6. Click ‘Import’ 

 
(Alternatively, you can import the source into the Web Content folder by clicking on the folder, selecting the  
‘Data’ tab on the ribbon at the top of the screen, selecting the ‘From Other Sources’ option in the ‘Import’ 
group and selecting ‘From NCapture…’.) 

 

http://help-ncapture.qsrinternational.com/desktop/welcome/welcome.htm
http://www.ncfieldfamily.org/farm/north-carolina-fishing-industry-changes/
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2.5      Opening Sources  
 
To open one of the sources you have imported simply double click on it in the List View (after opening the 
appropriate folder in the Navigation View first if required); the source will then display in the Details View on 
the right. Note that you can open multiple sources at once if you wish, navigating between them by clicking on 
the tabs at the top of the Details View. For example, open up the Margaret and Helen sources from the 
Interviews folder, along with the Analyzing Estuarine Shoreline Change source from the Literature folder.  
 
These, and other, sources may already be as you want them, or you may wish to work with them and/or edit 
them. The following sections describe some of the things you may wish to do. 
 

2.6      Editing a Document Source 
 
To edit a document that is open in the Details View, for example the Margaret source, simply select ‘Click to  
Edit’. Once you have done this you can make any changes to the document you wish, and you can also run a 
spell check on the document by selecting the ‘Home’ tab on the ribbon at the top of the screen and then 
selecting the ‘Spelling’ option in the ‘Proofing’ group.  
 

2.7      Transcribing an Audio or Video Source 
 

To transcribe an audio or video source that is open in the Details View, for example the Helen source, again you 
first need to select ‘Click to Edit’. When you do this you will notice that a new row appears underneath the 
waveform image of the audio file; this is where you will transcribe it. The default is for only two columns of 
information, Timespan and Content, but if you wish to add more (for example a Notes column) go to: 

 
File -> Project Properties (under the ‘Project Information’ heading) 
 
Then in the ‘Project Properties’ dialog box that opens: 

1. Select the ‘Audio/Video’ tab  
2. Select either the ‘Audio’ or ‘Video’ tab under the ‘Custom Transcript Fields’ heading, as appropriate 
3. Select the ‘New’ button (note you can also remove a column you have created by selecting it and 

pressing the ‘Remove’ button) 
4. Type in the name of your new column (e.g. Notes) 
5. Select ‘Apply’ to apply the change while keeping the dialog box open, or ‘OK’ to apply the change and 

close the dialog box  
 
Once you are happy with the columns for your transcript there are two ways you can transcribe the source; you 
can choose between these in the ‘Playback’ group found in the ‘Media’ tab that will have appeared on the 
ribbon at the top of the screen (see below). The first, default, option is using the ‘Normal’ Play Mode.  
Transcribing in this way requires you to enter the timespans for your transcript manually, and you can begin a 
new row whenever you like (typically when there is a change of speaker). The second option is using the  
‘Transcribe’ Play Mode. Transcribing in this way means the timespans will be entered for you automatically, 
with timespans beginning and ending when you press play and stop respectively (note that pausing means you 
continue with the current timespan).  
 
Whichever way you transcribe, note that you can alter the speed of the audio or video file by selecting the  
‘Play Speed’ icon also found in the ‘Playback’ group in the ‘Media’ tab. 

 
 
 
 

 
 

 
 
Note that transcribing audio or video files in NVivo is just one way of working with them; for information on 
other methods, and for more information about transcribing in NVivo, go to: 
 
http://help-nv11.qsrinternational.com/desktop/concepts/about_audio_or_video_transcripts.htm 

         Normal      Transcribe  Play Speed  

http://help-nv11.qsrinternational.com/desktop/concepts/about_audio_or_video_transcripts.htm
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2.8      Creating a Picture Source from a PDF 
 

To turn a picture found in one of your PDF sources, for example the large Figure 3 on page 821 of the Analyzing  
Estuarine Shoreline Change PDF, into a source of its own, do the following: 

1. Click on the picture in the PDF source so that it is selected (i.e. surrounded by a dotted line; right click 
and change the ‘Selection Mode’ to ‘Region’ first if necessary) 

2. Right click and select ‘Copy’ 
3. Select the folder where you want to place the new picture source from the list of folders in the 

Navigation View (e.g. Pictures) 
4. Right click in the blank area in the List View for that folder 
5. Select ‘Paste’ 
6. Enter a name for the picture, and a description if you wish, and click ‘OK’ 

 
2.9      Working with Other Types of Sources 
 

For information on working with other types of sources, e.g. pictures and datasets, go to: 
 
http://help-nv11.qsrinternational.com/desktop/concepts/about_sources.htm 

 
3 Nodes and Coding 
  

Materials on a particular topic, theme, concept, etc. can be viewed together in one place (and hence analysed) 
in NVivo by storing them in what is called a node. This section looks at how you can create and manage nodes, 
and at how you can code (allocate) materials to them. 

 
3.1      Creating Nodes and Coding Material 
  

There are a few different ways you can create new nodes, depending on whether you set up all your nodes first 
and then code, or whether you create new nodes as you code (or you may wish to do a combination of both).  

 
To create a node before you begin coding, for example a Development node, do the following: 

1. Click ‘Nodes’ in the Navigation View  
2. Right click in the white space in the List View and select ‘New Node…’  
3. Type in the name of the node (e.g. Development), and add a Description and Nickname if you wish 
4. Click ‘OK’ 

 
(Alternatively, you can do this by clicking ‘Nodes’ in the Navigation View, selecting the ‘Create’ tab on the 
ribbon at the top of the screen, and then selecting the ‘Node’ option in the ‘Nodes’ group.) 
 
As an example of creating a node as you code, open the Maria and Daniel interview source and scroll down to 
the ‘Q.4. Community and environmental change’ heading, then continue scrolling to Elizabeth’s second 
question (on fisheries) and Daniel’s response. To code this response to a new node, for example a Fishing  
Industry node, do the following: 

1. Highlight the text 
2. Right click and select ‘Code…’ 
3. Click on the ‘New Node’ button at the bottom of the dialog box that appears 
4. Type in the name of the new node (e.g. Fishing Industry) 
5. Click ‘OK’ 

 
You can then check that the text you selected has been coded to the new node by clicking on ‘Nodes’ in the  
Navigation View and double clicking on the Fishing Industry node. 
 
You would have observed that you can also use this method to code material to existing nodes; another way of 
doing this is simply by dragging and dropping the text to the required node. For example, you can code text 
from the Maria and Daniel source to the Development node by doing the following: 

1. Open the source (e.g. the Maria and Daniel source) 
2. Highlight the part of the text you wish to code (e.g. a portion relating to development) 
3. Click ‘Nodes’ in the Navigation View 

http://help-nv11.qsrinternational.com/desktop/concepts/about_sources.htm
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4. Hold down the left mouse button and drag the highlighted text to the node you wish to code to (e.g. 
the Development node) 

Once you have done this, repeat the process for the Margaret source. 
 

Note that you can also code material from existing nodes (as opposed to material from sources) to new or 
existing nodes using the methods described above; this is known as ‘coding on’. 

 
3.2      Uncoding Material 

 
The easiest way to uncode (remove) material you have previously coded to a node is to highlight the text you 
wish to uncode (either in the source or in the node), then right click and select either:  

• ‘Uncode…’ to select the node(s) you wish to uncode from, from the dialog box that appears; 
• ‘Uncode from Recent Nodes’ to select the nodes you wish to uncode from, from the list of recent 

nodes displayed; or (if you are in the node) 
• ‘Uncode from This Node’ to uncode from the node you are in. 

 
Alternatively, if you simply wish to make a change to material that has been coded, such as a correction to 
spelling, make the change in the source itself and it will then be updated in the node. 

 
3.3      Coding Stripes 
 

Coding stripes are coloured stripes that you can choose to display in the Details View of a source (or a node if 
you have coded on), indicating what has been coded where for up to seven nodes. Coding stripes also enable 
you to see how much of a source has been coded and, if you are working in a team, which coding has been 
done by specific users. 
 
To display coding stripes, for example for the Maria and Daniel source, do the following: 

• Open the source (or node) in the Details View  
• Select the ‘View’ tab on the ribbon at the top of the screen 
• Select the ‘Coding Stripes’ option in the ‘Coding’ group 
• Select the type of coding stripes you would like, for example ‘Nodes Recently Coding’  

 
For this particular example, you should observe that the coding stripes show which sections of the Maria and  
Daniel source have been coded to the Development and Fishing Industry nodes. 

 
3.4      Exploring Nodes 
 

You can view all the material you have coded to nodes by opening the various nodes in the Details View. For 
example, if you open the Development node you will notice that there are three tabs on the right hand side;  
Summary, Reference and Text. These tabs are as follows: 

• the Reference tab is the default display tab, showing the content that has been coded from each 
source; 

• the Summary tab summarises the sources that have been coded to the node; and 
• the Text tab displays content that has been coded to the node for each text source individually. 

 
Note that if there were any other types of sources coded to the node, such as picture sources, then the content 
for each such source would be displayed in an appropriate tab (e.g. a Picture tab). 
 
If at any time you decide you want to make changes to your nodes, for example moving, merging and/or 
renaming them, you can do so with relative ease (although it might be worth saving a copy of your original 
project first just in case). The procedures for making these changes are described in the following sections. 

 
3.5      Creating Sub-Nodes and Moving Nodes 
 

Once you have started creating nodes you might find that you wish to create sub-nodes of parent nodes; you 
can do this simply by right-clicking on the parent node in the List View and selecting ‘New Node…’.  
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Alternatively, if you want to rearrange your nodes and make an existing node a sub-node of another existing 
node you can do that too. As an example, create a new node Zoning. To then move this node to sit as a sub-
node under the Development node, do the following: 

1. Right click on the node you want to make the sub-node (e.g. Zoning) 
2. Select ‘Cut’ 
3. Right click on the node you want to make the parent node (e.g. Development) 
4. Select ‘Paste’ 

 
The Zoning node then becomes a sub-node of the Development node: 
 

 
 
 
 
 
 
 
 

 
3.6      Merging Nodes 

 
You also might find that you eventually want to merge two or more nodes that you originally created as 
separate nodes (with similar themes). 
 
As an example, create a new node Sustainable Fishing, then open the Margaret source and code the portion of 
text pertaining to sustainable fishing (as part of Margaret’s response to Nancy’s question on the future of the 
fishing industry under the ‘Q.2. Connection to Down East natural environment’ heading) to it.  
 
To then merge this node with the Fishing Industry node, do the following: 

1. Right click on the node you wish to merge (e.g. the Sustainable Fishing node) 
2. Select ‘Cut’ 
3. Right click on the node you wish to merge into (e.g. the Fishing Industry node) 
4. Select ‘Merge into Selected Node…’ 
5. Click ‘OK’ 

 
The Sustainable Fishing node is then merged with the Fishing Industry node, which should now have two 
references coded to it (the original Fishing Industry reference along with the Sustainable Fishing reference just 
coded): 
 

 
 
 
 
 
 
 
 
3.7      Renaming Nodes 

 
To rename a node, for example the Fishing Industry node to simply Fishing, do the following: 

1. Right click on the node you wish to rename (e.g. the Fishing Industry node) 
2. Select ‘Node Properties…’ 
3. Enter a new name for the node (e.g. Fishing) 
4. Click ‘OK’ 

 
4 Running Queries 

 
In addition to coding, you can also run queries to search your material for specific words or phrases, or to 
search for frequently occurring words. This section looks at some examples of common queries. 
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4.1      Running Text Search Queries 

 
A text search query is used to search project items and folders (e.g. all source materials, source materials in a 
specific folder, material coded to nodes, etc.) for specific words and phrases.  
 
To run a text search query, for example to search for the word economy, do the following: 

1. Click ‘Queries’ in the Navigation View 
2. Right click in the white space in the List View and select ‘New Query’, then ‘Text Search’ 
3. Choose where you would like to search; the default is ‘All Sources’, but if you would like to search 

specific items or folders then click on the appropriate button and make your selections in the dialog 
box that appears 

4. Enter the text to search for in the ‘Search for’ box (e.g. economy); you can enter multiple words if 
required 

5. Choose how precise you wish to be with words in your search using the ‘Find’ slider on the right (e.g. 
choose to search for Exact matches, including stemmed words, including synonyms, etc.) 

6. Select ‘Run Query’ 
 

 
 
(Alternatively, you can run a text search query by selecting the ‘Query’ tab on the ribbon at the top of the 
screen, and selecting the ‘Text Search’ option in the ‘Create’ group.) 
 
The results of the text search query will then be displayed underneath in a series of tabs: 

• the Summary tab is the default display tab, showing all sources that contain the search word(s), and 
the number of occurrences; 

• the Reference tab displays a snippet of the context of each instance of the search word, sorted by 
source (note that to view more of the context you can right click on the selected instance, then select 
‘Coding Context’ and change it, e.g. from ‘Narrow’ to ‘Broad’);  

• the Text and PDF tabs do the same, but each source is displayed on a separate page; and 
• the Word Tree tab displays the results of the search in a word tree, with the search term in the middle 

and the preceding and subsequent text on either side (listed alphabetically). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Once you have run a text search query you can choose to save the results either as a new node (or merged with 
an existing node), or a new query, by selecting the ‘Save Results…’ or ‘Add to Project’ buttons respectively.  
For example, to save the results as a new Economy node, do the following: 

1. Select ‘Save Results…’ 
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2. Choose whether to ‘Create Results as New Node’ or  ‘Merge Results into Existing Node’ (e.g. choose 
the former) 

3. Choose a Location; the default is to store the results node in the Results folder, but you can choose to 
store it in the Nodes or Cases folders instead (e.g. choose Nodes as the location for this example) 

4. Give a name to the new node (e.g. Economy), and a description if required  
5. Click ‘OK’ 

 
Note that again you can choose to see more of the context for each instance of the word in the new 
node/query by right clicking on the selected instance, then select ‘Coding Context’ and changing it. 
 

4.2      Running Word Frequency Queries 
 

A word frequency query is used to determine the most frequently occurring words in various project items and 
folders, and to display them in different ways. 
 
To run a word frequency query for the Interviews sources, for example, do the following: 

1. Click ‘Queries’ in the Navigation View 
2. Right click in the white space in the List View and select ‘New Query’, then ‘Word Frequency’ 
3. Choose where you would like to search; the default is ‘All Sources’, but if you would like to search 

specific items or folders then click on the appropriate button and make your selections in the dialog 
box that appears (e.g. click on the ‘Selected Items’ button and select the Interviews sub-folder in the 
Internals folder, then click ‘OK’, to run the query for the Interviews sources only) 

4. Enter the number of words you would like displayed (e.g. 20), and the minimum length (keep as 3) 
5. Choose how precise you wish to be with words in your search using the ‘Grouping’ slider on the right 

(e.g. choose to search for Exact matches, to group stemmed words, to group synonyms, etc.) 
6. Select ‘Run Query’ 

 

 
 
(Alternatively, you can run a word frequency query by selecting the ‘Query’ tab on the ribbon at the top of the 
screen, and selecting the ‘Word Frequency’ option in the ‘Create’ group.) 
 
The results of the word frequency query will then be displayed underneath in a series of tabs, two of which are: 

• the Summary tab (the default display tab), which shows the most frequently used words and the 
number of occurrences; and 

• the Word Cloud tab, which displays the most frequently occurring words in a word cloud. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Once you have run a word frequency query you can choose to save the results in the Queries folder by selecting 
the ‘Add to Project…’ button and naming the query as appropriate. 
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